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LINCOLN UNIVERSITY COLLEGE 
FACULTY OF SCIENCE (DEPARTMENT OF BIOTECHNOLOGY) 

LABORATORY SAFETY RULES 
 
 

The following rules must be obeyed by all students in the science laboratory of the faculty. 
Wilful or repeated in advertent non-compliance may result in dismissal or suspension from the 
laboratories 
 

• No entry without permission: 
- Outsiders are not allowed to enter the laboratory without permission. 
- No student is allowed to enter the laboratory unless permission has been given by a laboratory 

assistant or a lecturer. 
 

• At work in the laboratory: 
- No experiment may be attempted without the knowledge and permission of a lecturer. 
- Students must wear shoes in the laboratory. Students wearing slippers or sandals are not allowed to 

work in the laboratory. 
- Lab coat must be worn at all times during practical work in the laboratory. 
- Do not mouth pipette chemicals. 
- Do not eat or smoke in the laboratory. 
- Do not taste any chemicals, including dilute solutions. If any acid or alkali accidentally enters your 

eyes or mouth, wash immediately with plenty of tap water. Inform your lecturer, and seek medical 
attention if necessary. 

- Paper should be used to light up the Bunsen burners. 
- Used match sticks, filter papers, and other solid waste must never be thrown into the sinks. They 

must be thrown into the dustbins provided. Lighted match sticks and smoldering materials must be 
extinguished with tap water before thrown in to the dustbins. 

- Any equipment broken or damaged must be reported to the laboratory assistant. 
 

• Before leaving the laboratory: 
- All the equipment and benches must be cleaned at the end of each practical session. 
- Wash hands and arms with soap and water before leaving the laboratory. 
- No student is allowed to take away any chemicals, equipment or other property of the laboratory. 
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     INTRODUCTION 
 

1. The Scientific Method 
- Making observations 
- Generating hypotheses 
- Making predictions 
- Designing and carrying out experiments 
- Constructing scientific models 

 
2. Practical  Exercises  
  To get the most out of the practical exercises, you need to follow carefully the instructions 

given. These instructions have been designed to provide you with the experience in the following skills: 
- Following instructors 
- Handling apparatus  
- Having due regard for safely  
- Making accurate observations 
- Recording results in an appropriate form 
- Presenting quantitative results 
- Drawing conclusions 

 
3. Following Instructions  
  Instructions are provided in the order in which you need to carry them out. We would advise 

that before carrying out the instructions, you read through the entire exercise. This will help you to 
remember what you have learned. 

  Each practical exercise in the book begins with a few lines describing its purpose in most cases 
the following headings are also used: 
- Procedure-numbered steps that need to be carried out. 
- For consideration -some questions to help you think carefully about the results you have obtained. 
- Materials-a list of the apparatus, chemicals and biological materials you need. 
 

4. Handling apparatus  
  Biologists need to able to use many different types of apparatus, for example, photometers (to 

measure water uptake by plants), respirometers  (to measure oxygen uptake or carbon dioxide 
production), Petri dishes (for plating out bacteria and other microorganisms) and the light microscope 
(to magnify specimens). Many of the practical exercises are designed to help you derive the maximum 
benefit from a piece of apparatus. 

 
5. Having Due Regard for Safety 
  Surveys have been shown that science laboratories are among the safest places to be. 

Nevertheless, this is no cause for complacency. 
- Always move slowly and carefully in a laboratory. 
- Never put your fingers in your mouth or eyes after using chemicals or touching biological specimens 

until you have washed your hands thoroughly with soap and warm water, and dried them. 
- Make sure glass objects (e.g, thermometers, beakers) cannot roll off tables or be knocked onto the 

floor. 
- Wear safely goggles whenever there is a risk of damage to the eyes. 

 
Situations of risk include: 

- Heating anything with  a Bunsen burner (even heating water has its dangers’) 
- Handling many liquids, particularly those identified as corrosive, irritant, toxic or harmful 
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- Handling corrosive or irritant solids 
- Some dissection work 
- Allow Bunsen burners, tripods, gauzez and beakers to cool down before handling them. 
- Never allow your own body fluids (especially blood and saliva) to come into contact with someone 

else, or theirs into contact with you. 
- Keep long hair tied back and do not wear dangly earrings. 
- Do not allow electrical equipment to come into contact with water. 
- If you are unsure how to carry out a scientific procedure, ask. 
- Make sure you understand why you are going to do something before you do it. 
- Wear a lab coat when using chemicals or handling any biological specimens. 
- Follow exactly agreed procedures with regard to cuts, burns, electric shocks and other accidents 

(e.g. with chemicals). 
- Follow exactly all specific safely instructions given in this book or provided by your teacher for 

particular practical exercises (e.g. use of gloves, disinfection) 

With practice, these procedures should become second nature to you. They will enable you to carry out 
practical work in safety. 

6. Making Accurate Observations  
  In most cases the practical exercise will make it clear what you need to observe, e.g. the time 

taken for a certain volume of gas to be evolved or the width of a sample cells. Ensure that you know 
how to use any necessary equipment before starting practical. Think carefully about the precision with 
which you will make your observations. 

 
7. Recording Results in an Appropriate Form 
  Results can be recorded in various ways. Often it is helpful to record raw data in a table. Most 

data will be in the form of numbers, i.e. they will be quantitative data (also known as numerical data). 
However, some data, e.g. flower colour, will be qualitative data. 

  One form in which some biological findings can be recorded is a drawing. You don’t need to be 
professional artist to make worthwhile biological drawings. If you follow the following guidelines, a 
drawing can be of considerable biological value: 

- Ensure that your completed drawing will cover at least a third of A4 page. 
- Plan your drawing so that the various parts are is proportion and will not be drawn too small. 

Small marks to indicate the length and breadth of the drawing are a great help in planning and a 
faint outline can be rapidly drawn to show the relative positions of the parts. 

- The final drawing should be made with clean, firm lines using a sharp HB pencil and, if needed, a 
good quality eraser (not a fluid).If important details are too small to be shown in proportion, they 
can be put in an enlarged drawing at the side of the main drawing. 

- Avoid shading and the use of colour unless you are an excellent artist and they really help, for 
example when drawing soil profiles. 

- When drawing structures seen with the naked eye or hand lens, use two lines to delineate such 
things as blood vessels and petioles. This will help you to indicate the relative widths of such 
structures. 

- When drawing low power plan drawings from the light microscope, do not attempt to draw 
individual cells-just different tissues. 

- When drawing plant cells at high power under the light microscope, use two lines to indicate the 
width of cell walls, but a single line to indicate a membrane. 

- Always put a scale on each drawing. 
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8. Presenting Quantitative Results 
  Presentation of data is all about using graphs or other visual means to make it easier to see 

what your results tell you. The following four ways of presenting data are the most frequently used in 
biology: line graphs, bar charts, histograms and scatter graphs (Figure 1). 

       
 

                        
       Figure 1: Line graphs, bar charts, histograms and scatter graphs 
 
9. Drawing Conclusions 
  Finally, you will need to draw conclusions. If your practical exercise has involved the testing of 

a hypothesis, for example that the enzyme pepsin works better at low pH than in neutral or alkaline 
conditions, your conclusion should indicate whether the hypothesis has been refuted (i.e. shown not to 
be the case) or supported. Of course, even if your hypothesis has been supported, it doesn’t mean that 
it has been confirmed with 100% certainty- in other words it isn’t proved. Science proceeds more by 
showing that certain ideas are wrong than by showing that others are right (think about that!). Your 
conclusion might therefore include further ways of testing the original hypothesis, or might raise new 
possibilities to be investigated. 

  Often you will only be able to arrive at your conclusions after statistically analysing your data. 
 
 
10. Writing a Scientific Lab Report 

 Title 
- Communicate the subject investigated in the paper. 
 
Introduction 
- State the hypothesis. 
- Give well-defined reasons for making the hypothesis. 
- Explain the biological basis of the experiment. 
- Cite sources to substantiate background information. 
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- Explain how the method used will produce information relevant to your hypothesis. 
- State a prediction based on your hypothesis. (If the hypotheis is supported, then the results will be.) 

 
Materials and Methods 

- Use the appropriate style. 
- Give enough detail so the reader could duplicate your experiment 
- State the control treatment, replication and standardized variables that were used. 

 
Results 

- Summarize the data (do not include raw data). 
- Present the data in an appropriate format (table or graph). 
-  Present tables and figures neatly so they are easily read. 
- Label the axes of each graph completely. 
- Give units of measurement where appropriate. 
- Write a descriptive caption for each table and figure. 
- Include a short paragraph pointing out important results but do not interpret the data. 

 
Discussion 

- State whether the hypothesis was supported or proven false by the results, or else state that the 
results were inconclusive. 

- Cite specific results that support your conclusions. 
- Give the reasoning for your conclusions. 
- Demonstrate that you understand the biological meaning of your results. 
- Compare the results, with your predictions and explain any unexpected results. 
- Compare the results to other research or information available to you. 
- Discuss any weaknesses in your experimental design or problems with the execution of the 

experiment. 
- Discuss how you might extend or improve your experiment. 

 
Conclusion 

- Restate your conclusion. 
- Restate important results. 

 
Literature Cited 

- Use the proper citation form in the text. 
- Use proper citation form in the Literature Cited section. 
- Refer in the text to any source listed in this section. 

 
Acknowledgement 

- State any appropriate acknowledgement that you think is necessary. 
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Practical 1 
Title: Word processing and spreadsheet 
 
Objectives:  
After completing the practical, you will be able: 

1. To format and prepare a word document for a project 
2. To introduce Microsoft Excel’s working environment  

 
PART I: Microsoft Word – formatting of a word document for a project 
 
Introduction 

 Microsoft Word is a word processor developed by Microsoft. It was first released on October 
25, 1983 under the name Multi-Tool Word for Xenix systems. Subsequent versions were later written 
for several other platforms including IBM PCs running DOS (1983), Apple Macintosh running Classic 
Mac OS (1985), AT&T Unix PC (1985), Atari ST (1988), OS/2 (1989), Microsoft Windows (1989), SCO 
Unix (1994), and macOS (2001). Commercial versions of Word are licensed as a standalone product or 
as a component of Microsoft Office, Windows RT or the discontinued Microsoft Works suite. Microsoft 
Word Viewer and Office Online are freeware editions of Word with limited features. 
 
 
Procedure: 
1. Open Microsoft Office – MS Word – File – New.  
2. Continuous page numbers except first page  
3. Line numbers 
4. Save the document as “Computer Practical 1” in your pen drive 
5. Make a title page: 
o Specify margins to 3cm all sides 
o Title of proposed project: (you may search for a computer-biotechnology related paper from internet) 
 Change case to uppercase 
 Bold  
 Times New Roman  
 Italic the scientific name  
 Centered 
 No after and before spacing  
 Line spacing 1.15  
o Full name 
 Change case to uppercase 
 Normal   
 Times New Roman  
 Centered 
o Matric number of the student 
o Name of the subject and your department 
o Name of the University; and 
o Name of your lecturer 
o The month and year of the project 
 
 All follow same features as the earlier 
6. Abstract page: 
o Specify margins to 3cm all sides 
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o Copy (from the online source) and past. 
o Modify the text where applicable. 
o Align the text to both left and right margins (Justify) 
o Use sentence case option. 
o Times New Roman 
o Size 12 
o Title bold  
o Text normal 
o Italic the scientific names 
o Line spacing 1.5 
7. Introduction: 
o One page only 
o Specify margins to 2.5cm all sides 
o Select, copy and compile (from the online source) and past. 
o Align the text to both left and right margins (Justify) 
o Use sentence case option. 
o Times New Roman 
o Size 12 
o Title bold  
o Text normal 
o Italic the scientific names 
o Line spacing 1.5 
o Paragraph indent, first line 0.2” 
o After spacing paragraph 
8. Main text: 
o Specify margins to 2.5cm all sides 
o Select, copy and compile (from the online source) and past. 
o Align the text to both left and right margins (Justify) 
o Use sentence case option. 
o Times New Roman 
o Size 12 
o Title bold  
o Text normal 
o Italic the scientific names 
o Line spacing 1.5 
o Paragraph indent, first line 0.2” 
o After spacing paragraph 
o Make a table (at least 4x4) in the middle of the text 
o Make one landscape page in the middle of the text and insert a picture with Figure legends 
 
 
 
PART II: Microsoft Excel – Working Environment 
 
 

 

 

 

Practice: Generate a word document by following the above instructions. 
Attach a copy of the document to your practical report. 
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Introduction 

 Excel is a spreadsheet program in the Microsoft Office system. You can use Excel to create 
and format workbooks (a collection of spreadsheets) in order to analyze data and make more informed 
business decisions. Specifically, you can use Excel to track data, build models for analyzing data, write 
formulas to perform calculations on that data, pivot the data in numerous ways, and present data in a 
variety of professional looking charts. 
 
Procedure: 
Opening Microsoft Excel: 
You may have a shortcut to Excel on your desktop, if so double click the icon and Excel will open.  If 
not follow the steps below: 
1.   Click on the Start button 
2.   Highlight Programs 
3.   Highlight Microsoft Office 
4.   Click on Microsoft Excel 
Create a New Workbook 
1.  Click the File tab and then click New. 
2.  Under Available Templates, double click Blank Workbook or Click Create. 
Enter Data in Worksheet 
1.   Click the cell where you want to enter data. 
2.   Type the data in the cell. 
3.   Press enter or tab to move to the next cell. 
                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                       
Select Cells and Ranges 
In order to complete more advanced processes in Excel you need to be able to highlight or select cells, 
rows and columns. There are a variety of ways to do this, see the table below to understand the 
options. 

 
 
Modifying Spreadsheets 
In  order  to  create  an  understandable  and  professional  document  you  will  need  to  make 
adjustments to the cells, rows, columns and text.   Use the following processes to assist when creating 
a spreadsheet. 
Cut, Copy, and Paste Data 
You can use the Cut, Copy, and Paste commands in Microsoft Office Excel to move or copy entire cells 
or their contents.  NOTE: Excel displays an animated moving border around cells that have been cut or 
copied. To cancel a moving border, press ESC. 
Move/Copy Cells 
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When you move or copy a cell, Excel moves or copies the entire cell, including formulas and their 
resulting values, cell formats, and comments. 
1.  Select the cells that you want to move or copy. 
2.  On the Home tab, in the Clipboard group, do one of the following: 
a.  To move cells, click Cut. b. To copy cells, click Copy. 
3.  Click in the center of the cell you would like to Paste the information. 
4.  On the Home tab, in the Clipboard group, click Paste. 
Set Column/Row Width/Height with Mouse 
To change the width of one column/row 
1.  Place you cursor on the line between two rows or columns. 
2.  A symbol that looks like a lower case t with arrows on the horizontal line will appear 
3.  Drag the boundary on the right side of the column/row heading until the column/row is the width that 
you want. 
To change the width of multiple columns/rows 
1.  Select the columns/rows that you want to change 
2.  Drag a boundary to the right of a selected column/row heading. 
3.  All selected columns/rows will become a different size. 
To change the width of columns/rows to fit the contents in the cells 
1.  Select the column(s) or row(s) that you want to change 
2.  Double-click the boundary to the right of a selected column/row heading. 
3.  The Column/Row will automatically be size to the length/height of the longest/tallest text. 
Merge and Center Cells 
1.  Select two or more adjacent cells that you want to merge. 
2.  On the Home tab, in the Alignment group, click Merge and Center. 
3.  The cells will be merged in a row or column, and the cell contents will be centered in the merged cell 
Merge Cells 
To merge cells only, click the arrow next to Merge and Center, and then click Merge Across or Merge 
Cells. 
Split Cells 
1.  Select the merged cell you want to split 
2. To split the merged cell, click Merge and Center. The cells will split and the contents of the merged 
cell will appear in the upper-left cell of the range of split cells. 
Automatically Fill Data 
To quickly fill in several types of data series, you can select cells and drag the fill handle.  
To use the fill handle, you select the cells that you want to use as a basis for filling additional cells, and 
then drag the fill handle across or down the cells that you want to fill. 
1.  Select the cell that contains the formula that you want to be brought to other cells. 
2.  Move your curser to the small black square in the lower-right corner of a selected cell also know as 
the fill handle. Your pointer will change to a small black cross. 
3.  Click and hold your mouse then drag the fill handle across the cells, horizontally to the right or 
vertically down, that you want to fill. 
4.  The cells you want filled will have a gray looking border around them.  Once you fill all of the cells let 
go of your mouse and your cells will be populated. 
Formatting Spreadsheet 
To further enhance the spreadsheet we format a number of elements like text, numbers, coloring and 
table styles. 
Wrap Text: 
You can display multiple lines of text inside a cell by wrapping the text. Wrapping text in a cell does not 
affect other cells. 
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Click the cell in which you want to wrap the text. 
2.  On the Home tab, in the Alignment group, click Wrap Text. 
3. The text in your cell will be wrapped. 
Cell Borders: 
By using predefined border styles, you can quickly add a border around cells or ranges of cells. If 
predefined cell borders do not meet your needs, you can create a custom border. 
Apply Cell Borders: 
1.   On a worksheet, select the cell or range of cells that you want to add a border to, change the border 
style on, or remove a border from. 
2.  Go to the Home tab, in the Font group 
3.  Click the arrow next to Borders 
4.  Click on the border style you would like 
5. The border will be applied to the cell or cell range NOTE: To apply a custom border style, click More 
Borders. In the Format Cells dialog box, on the Border tab, under Line and Color, click the line style and 
color that you want. 
Remove Cell Borders: 
1.  Go to the Home tab, in the Font group 
2.  Click the arrow next to Borders 
3.  Click No Border. 
Cell Styles 
You can create a cell style that includes a custom border, colors and accounting formatting. 
1.  On the Home tab, in the Styles group, click Cell Styles.  
2.  Select the different cell style option you would like applied to your spreadsheet. 
Cell and Text Coloring 
You can also modify a variety of cell and text colors manually. 
Cell Fill  
1.  Select the cells that you want to apply or remove a fill color from. 
2.  Go to the Home tab, in the Font group and select one of the following options: 
a. To fill cells with a solid color, click the arrow next to Fill Color, and then under Theme Colors or 

Standard Colors, click the color that you want. 
b. To fill cells with a custom color, click the arrow next to Fill Color, click More Colors, and then in the 
Colors dialog box select the color that you want. 
c. To apply the most recently selected color, click Fill Color. 
Remove Cell Fill  
1.  Select the cells that contain a fill color or fill pattern. 
2. On the Home tab, in the Font group, click the arrow next to Fill Color, and then click No Fill. 
Text Color 
1.  Select the cell, range of cells, text, or characters that you want to format with a different text color. 
2.  On the Home tab, in the Font group and select one of the following options: 
a. To apply the most recently selected text color, click Font Color 
b. To change the text color, click the arrow next to Font Color, and then under Theme Colors or 
Standard Colors, click the color that you want to use. 
Customize Worksheet Tab 
1.  On the Sheet tab bar, right-click the sheet tab that you want to customize 
2.  Click Rename to rename the sheet or Tab Color to select a tab color. 
3.  Type in the name or select a color you would like for your spreadsheet.  
4. The information will be added to the tab at the bottom of the spreadsheet. 
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Exercise: 
 
Lab Task 1: 
1. Enter the data “Sunday” into cell A1 and “Monday” into cell B1. 
2. Type in “17/08” into cell E8.  
3. Type in “2” into cell I8 and “4” into cell I9 
 
 Paste a screen picture from the output to your practical report. 

 
Notice how Excel automatically detected that 17/08 was a date and converted it to 17-Aug. We will 
discuss formatting data later on in this lab. Now, we want to select both cells A1 and B1 together. To do 
this, click A1 and without releasing the mouse button, move the mouse over cell B1.  
 
To get excel to auto-complete this row, we now position the mouse cursor at the bottom-left corner of 
the rectangle. Make sure the cursor has changed into a + sign. Now hold down the cursor and drag it to 
the left till I1. 
 
 Paste a screen picture from the output to your practical report. 

 
Lab Task 2: 
1. Auto-complete cells I8 and I9 all the way to I14. 
2. Auto-complete cell E8 all the way to E12. 
 
Basic Calculations: When working on a spreadsheet, you will almost definitely need to perform some 
calculations on the data you have. The first thing you need to remember about Excel calculations is that 
formulas always start with an = sign.  Let us begin with a very simple calculation.  Type “=3+5” into cell 
A5 as shown below. Press Enter. Excel automatically replaces the formula with the result of the 
equation. 
Now let us calculate the sum of the numbers in I8 and I9. In cell J10, type “=I8+I9”. One other option is 
to type in “=”, then select cell I8. After that, type in “+” and then select I9. 
Pressing Enter will give you the result of the calculation. Double clicking on the   cell   with   the formula 
allows you to edit the formula. Excel   has   built-in functions that make your life easier. One of them is 
the SUM function. In cell J11, type “=sum (“.  Now select both cells I8 and I9. Pressing Enter gives you 
the same result as the plus operation we did in cell J10. Try changing the value in cell I8 and notice 
how the change is reflected in both formulas. 
 
Lab Task 3: 
1.  Open Sheet 2 in your workbook. 
2.  In cells A1 and A2, type 1000 and 1500 respectively. 
3.  Use auto-complete to fill in cells A3 to A8. 
4.  Calculate the following values for cells A1 to A8 using built-in Excel functions: 
a)  Sum 
b) Maximum c) Minimum d) Average 
e)  Median 
f) Standard deviation 
5.  Enter the number 5000 into cell A9 and modify all the above formulas to include it.  
6.  Calculate the sum of the Maximum and Minimum, and then divide this number by the standard 
deviation. 
 
 

Notice: Generate an Excel spreadsheet and carry out the lab tasks by following the 
above instructions. Attach screenshot pictures of the spreadsheets to your 
practical report. 
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Practical 2 
Title: EndNote | Thomson Reuters 
 
Objective:  
After completing the practical, you will be able: 

1. To understand the  EndNote | Thomson Reuters, EndNote styles, working with references and 
citations; and formating thesis and article citations 

 

Introduction: 

EndNote is the standard software tool for publishing and managing bibliographies, citations and 
references on the Windows and Macintosh desktop. EndNote is a commercial reference management 
software package, used to manage bibliographies and references when writing essays and articles. It is 
produced by Thomson Reuters. 

 

Getting Started: 

Install EndNote: follow by the steps and instructions. 

 

Opening EndNote: 

You may have a shortcut to Excel on your desktop, if so double click the icon and EndNote will 
open.  If not follow the steps below: 

-   Click on the Start button 

-   Highlight Programs 

-   Highlight EndNote 

-   Click on EndNote 

 

Exercise: 

1. Open Microsoft Office – MS Word – File – New.  
2. Continuous page numbers except first page  
3. Save the document as “Computer Practical 3” in your pen drive 
4. Make a title page: 
o Specify margins to 1” all sides 
o Title of project: (you may search for a paper from internet) 
 Change case to uppercase 
 Bold  
 Times New Roman  
 Italic the scientific name  
 Centered 
 No after and before spacing  
 Line spacing 1.15  
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o Full name 
 Change case to uppercase 
 Normal   
 Times New Roman  
 Centered 
o Matric number of the student 
o Name of the subject and your department 
o Name of the University; and 
o Name of your lecturer 
o The month and year of the project 
 All follow same features as the earlier 

 
5. Main text: 
o Specify margins to 1” all sides 
o Select, copy and compile (from the online source) and past. 
o The text should include at least 10 citations. 
o Align the text to both left and right margins (Justify) 
o Use sentence case option. 
o Times New Roman 
o Size 12 
o Title bold  
o Text normal 
o Italic the scientific names 
o Line spacing 1.5 
o Paragraph indent, first line 0.2” 
o After spacing paragraph 

 
6.   EndNote: 

• Select and find a journal style that has not listed in the software default (e.g. Biodiversity journal). 
The styles can be found by searching “EndNote styles”.   

• Transfer the file to Program Files/Endnote/Styles 
• Compare the references from the original source to the style imported. Then, make the necessary 

amendments. 
• Open scholar.google.com 
• Click on settings 
• Search results 
• Bibliography manager 
• Show links to import citations into EndNote 
• Search the title of references in the Google Scholar 
• Import to EndNote 
• Make the necessary changes into imported references from Google scholar. 
• Save 
• Save library as a copy in your pen drive as backup 
• Open your word document 
• Click on Endnote menu 
• Insert citation 
• Find your reference 
• Insert in the correct part of your text 
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• The same action for the rest of references 
• Change the style to Biodiversity 
• Update the citations 
• After final check and completing, convert the citations to plain text 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



15 
 

Practical 3 
Title: Statistical analysis software: SPSS Inc. 
 
Objective: 

After performing this practical, students should have the knowledge of: 

 SPSS statistical software 

• Data editor 
• Output viewer 
• Syntax editor 
• Script window 
 

Introduction: 

Originally it is an acronym of Statistical Package for the Social Science but now it stands for Statistical 
Product and Service Solutions 

One of the most popular statistical packages which can perform highly complex data manipulation and 
analysis with simple instructions 

 

Procedure: 

Getting Started: 

Install SPSS: follow by the steps and instructions. 

Opening EndNote: 

You may have a shortcut to SPSS on your desktop, if so double click the icon and SPSS will 
open.  If not follow the steps below: 

1.   Click on the Start button 
2.   Highlight Programs 
3.   Highlight SPSS 
4.   Click on SPSS 
 

Comparing Means Of More Than Two groups 

One Way ANOVA 

The One Way ANOVA procedure compares means from several groups, simultaneously. Ideally, for 
this test, the subjects should be selected randomly within each group. 

Example 1. A researcher wants to evaluate the effects of four types of cereals (W,X,Y,Z) on weight 
gain. In a laboratory experiment, 20 mice were weighed and randomly assigned to one of the four 
cereal types. Weight gain (gm) was recorded at the end of the study.  
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W X Y Z 
8 5 6 3 
8 6 5 8 
7 5 5 7 
8 6 6 2 
9 3 8 5 

One of the important assumptions is that the variance in weight gain must be similar across the cereal 
types. This condition is known as homogeneity. Then, the data must be normally distributed. The other 
condition is that the individuals in each group are independent of each other. 

Enter the data in SPSS 
Variable View 

 

Data View (Enter the weight gains in a single column, cereal type in the other) 
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To Obtain an Independent-Samples T Test 
From the menus choose:  

Analyze 
     Compare Means 
  One-Way ANOVA... 

  

Results  

 

 

 

From the ANOVA table, the p-value is 0.027 which is less than 0.05. 

Therefore at least one pair of cereals differs significantly in terms of weight gain. 

 

Then, check if the data are distributed normally. 

Descriptives

Weight Gain in gm

5 8.00 .707 .316 7.12 8.88 7 9
5 5.00 1.225 .548 3.48 6.52 3 6
5 6.00 1.225 .548 4.48 7.52 5 8
5 5.00 2.550 1.140 1.83 8.17 2 8

20 6.00 1.919 .429 5.10 6.90 2 9

W
X
Y
Z

Total

N Mean
Std.

Deviation
Std.
Error Lower Bound Upper Bound

95% Confidence Interval for Mean Mini
mum

Maxi
mum

Test of Homogeneity of Variances

Weight Gain in gm

3.000 3 16 .062

Levene
Statistic df1 df2 Sig.

ANOVA

Weight Gain in gm

30.000 3 10.000 4.000 .027
40.000 16 2.500
70.000 19

Between Groups
Within Groups
Total

Sum of
Squares df Mean Square F Sig.

p-value = 0.062 > 0.05  

Equality of variances assumption is met. 
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Since, the p-values of 0.200 and 0.170 are both more than 0.05, there is no significant departure from 
normality for the weight gain across different types of cereal. Thus, assumption is fulfilled. 

The next question is, which pairs differ significantly from each other? 

The Mean Plot 

 

 

 

 

Post Hoc Multiple Comparison 

Redo the analysis and from the pop up, click Post Hoc…  

 

Tests of Normality

.151 20 .200* .932 20 .170Weight Gain (gm)
Statistic df Sig. Statistic df Sig.

Kolmogorov-Smirnova Shapiro-Wilk

This is  a lower bound of the true significance.*. 

Lil liefors Significance Correctiona. 

W X Y Z

Cereal Type

5

5.5

6

6.5

7

7.5

8

M
ea

n 
of

 W
t.G

ai
n

From the mean plot, it can be seen 
that cereal W recoded the highest 
weight gain, while cereal X and 
cereal Z recoded the lowest weight 
gain. 

 

If there is a difference, obviously 
cereal W is significantly different 
from both X and Z. 
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Equal Variance Assumed: 

Choose one of these test is the 
assumption of equality of variances is 
acceptable. That is if the Levene’s Test 
gives a p-value > 0.05 

(Homogenous) 

 

Equal Variance Not Assumed: 

Choose of these test if Levene’s Test 
gives a p-value < 0.05 (Heterogeneous) 

 

In the case of the weight gains, we have homogeneity. Perhaps, we can try Duncan.  

Results 

 

From the Duncan’s Post Hoc Test, X, Z, Y are 
similar (p-value=0.358 >0.05). 

Y, W are similar (p-value=0.063 >0.063) 

 

X and Z are different from W. 

 

So, we can conclude that the weight gain in 
cereal W is significant higher compared to both 
X and Z. 

Example 2 
W X Y Z 

8 5 6 2 

8 6 5 8 

7 5 5 7 

8 6 6 2 

9 3 8 5 

 

 

Weight Gain in gm

Duncana

5 5.00
5 5.00
5 6.00 6.00
5 8.00

.358 .063

Cereal Type
X
Z
Y
W
Sig.

N 1 2
Subset for alpha = .05

Means for groups in homogeneous subsets are displayed.
Uses Harmonic Mean Sample Size = 5.000.a. 

Change
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Results 

 

 

 
From the ANOVA table the p-value is 0.031, which is less than 0.05. 

Therefore at least one pair of cereals differs significantly in terms of weight gain. 

Next question is, which pairs differ significantly from each other? 

Post Hoc Multiple Comparison 

Redo the analysis and from the pop out click Post Hoc…  

  

Equal Variance Assumed: 

Choose one of these test is the 
assumption of equality of variances is 
acceptable. That is if the Levene’s Test 
gives a p-value > 0.05 

 

(Homogeneous) 

Equal Variance Not Assumed: 

Choose of these test if Levene’s Test 
gives a p-value < 0.05 
(Heterogeneous) 

Descriptives

Weight Gain in gm

5 8.00 .707 .316 7.12 8.88 7 9
5 5.00 1.225 .548 3.48 6.52 3 6
5 6.00 1.225 .548 4.48 7.52 5 8
5 4.80 2.775 1.241 1.35 8.25 2 8

20 5.95 2.012 .450 5.01 6.89 2 9

W
X
Y
Z

Total

N Mean
Std.

Deviation
Std.
Error Lower Bound Upper Bound

95% Confidence Interval for Mean Mini
mum

Maxi
mum

Test of Homogeneity of Variances

Weight Gain in gm

4.184 3 16 .023

Levene
Statistic df1 df2 Sig.

ANOVA

Weight Gain in gm

32.150 3 10.717 3.827 .031
44.800 16 2.800
76.950 19

Between Groups
Within Groups
Total

Sum of
Squares df Mean Square F Sig.

p-value = 0.023 < 0.05  

Equality of variances assumption is not met. 
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In this case, since we do not have homogeneity, we have to choose a test from the lower half of the 
options. Perhaps, we can try Dunnett’s T3.  

Results 

 
From the Dunnett’s T3 Multiple Comparison, W and X are different from each other. 

(p-value = 0.013 < 0.05). All other cereals do not differ from each other pairwise. 

 

We conclude that the weight gain in cereal W is significant higher compared to both X.   

 

This could be surprising since from the descriptive table above we see that the mean of Z is the lowest, 
even lower than that on X. But look at the standard deviation. The standard deviation for Z is very much 
higher compared to that of X. 

Next, perhaps should try the nonparametric test.

Multiple Comparisons

Dependent Variable: Weight Gain in gm
Dunnett T3

3.000* .632 .013 .73 5.27
2.000 .632 .084 -.27 4.27
3.200 1.281 .234 -2.06 8.46

-3.000* .632 .013 -5.27 -.73
-1.000 .775 .731 -3.61 1.61

.200 1.356 1.000 -4.93 5.33
-2.000 .632 .084 -4.27 .27
1.000 .775 .731 -1.61 3.61
1.200 1.356 .922 -3.93 6.33

-3.200 1.281 .234 -8.46 2.06
-.200 1.356 1.000 -5.33 4.93

-1.200 1.356 .922 -6.33 3.93

(J) Cereal Type
X
Y
Z
W
Y
Z
W
X
Z
W
X
Y

(I) Cereal Type
W

X

Y

Z

Mean
Difference

(I-J) Std. Error Sig. Lower Bound Upper Bound
95% Confidence Interval

The mean difference is significant at the .05 level.*. 
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To Obtain a K Independent Samples Nonparametric Test 
From the menus choose:  

Analyze 
     Nonparametric Tests 
  K Independent Samples... 

 

 

Results 

Nonparametric Kruskal-Wallis Test 

 
 

The p-value of this test is 0.033, which is less than 0.05.  
There is some evidence based on ranking that there is a difference in weight gains.  
The mean rank for W 16.90 and for X it is 7.20.  
Thus, we can conclude that weight gain in W higher compared X. 
 
Rank Values 
 

W X Y Z 
17 6 10.5 1.5 
17 10.5 6 17 

13.5 6 6 13.5 
17 10.5 10.5 1.5 
20 3 17 6 

 
 
 
 
 
 

Ranks

5 16.90
5 7.20
5 10.00
5 7.90

20

Cereal Type
W
X
Y
Z
Total

Weight Gain in gm
N Mean Rank

Test Statisticsa,b

8.751
3

.033

Chi-Square
df
Asymp. Sig.

Weight Gain
in gm

Kruskal Wallis Testa. 

Grouping Variable: Cereal Typeb. 
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Exercises: 
 
1. The following are the BP measurements for a sample of Malays, Chinese and Indians. 

     
Malays  Chinese  Indians 

125 126 134  136 131 135  138 137 140 
132 125 130  135 136 132  147 142  
146    134 139      

 
 
 
2. Students’ Statistics marks for a random sample of nine students from three classes. 
 

Class A  Class B  Class C 
80 60 65  79 65 62  75 60 56 
76 55 78  75 65 75  70 70 60 
77 78 79  70 80 75  75 80 70 

 
 
 
3. Masses of miniature tomatoes produced in three greenhouses. 
 

Greenhouse 1 1.42 1.64 1.81 1.53 
Greenhouse 2 1.85 1.74 2.23 2.18 
Greenhouse 3 1.75 1.31 1.95 1.59 

 
 
 
4.   The percent porosity of crucibles fired at four different temperatures as follows: 
 

2600oF 2675oF 2750oF 2825oF 
18.8 
14.7 
14.9 
14.2 
15.3 

16.7 
14.3 
12.5 
12.6 
13.7 

15.7 
13.1 
11.5 
11.7 
11.3 

14.4 
11.9 
9.8 
11.3 
11.3 

 
 
 
5. The Air Pollution Index (API) over four locations in five towns at 5:00 pm on a particular day. 

     
T1 T2 T3 T4 T5 
200 199 175 202 200 
199 217 174 213 196 
192 198 180 218 198 
203 194 165 207 202 
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For the questions above 

a) Write an objective. 
b) Describe the measurements in each group. 
c) Test if the data are distributed normally. 
d) Test if the variances are similar (homogeneity). 
e) Test if there is a significant difference in means between the group measurements.  
f) Perform an appropriate Post Hoc test to compare group differences. 
g) Perform a nonparametric test and compare the result. 
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Practical 4 
Title: Basic computer programming: Qbasic 
 
Objective:  
After completing the practical, you will be able: 

1. To introduce basic computer programming using Qbasic software 
 
 
Introduction: 

 QB64 (originally QB32)[1] is a self-hosting BASIC compiler for Microsoft Windows, Linux and 
Mac OS X, designed to be compatible with Microsoft QBasic and QuickBASIC. QB64 is a C++ emitter, 
which is integrated with a C++ compiler to provide compilation via C++ code and GCC optimization. 
 
 QB64 implements most QBasic statements, and can run many QBasic programs, including 
Microsoft's QBasic Gorillas and Nibbles games. Furthermore, QB64 has been designed to contain an 
IDE resembling the QBASIC IDE. QB64 also extends the QBASIC programming language to include 
64-bit data types, as well as better sound and graphics support. It can also emulate some DOS/x86 
specific features such as INT 33h mouse access, and timers. 
 
Contents 

QB64 like any other compiler program has its own command. It may differ from one to another but in 
the end of the day it still compiles. So, here are listed several commands that are used in QB64: 
 
PRINT 
Writes text and numerical for example if the command is PRNT “Hello There Human”, it will show the 
word ‘Hello There Human’. 
 
SLEEP 
Stops the programs procedure to continue until any key is pressed. 
 
INPUT 
Request a STIRING or numerical keyboard entry from a program user. For example, INPUT “I AM A 
ROBOT” 
 
DIM 
Is used to declare a variable type or dimension. Usually use to be connected with input. 
 
DECLARE 
Used to tell that a SUB or FUNCTION is created to be used in the program. 
 
SUB 
Procedures are programs within programs that can return multiple calculations. 
 
END 
Required at the end of the block of library declarations. 
 
ELSEIF 
Used in IF…THEN block statements or block of statements. 
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IF 
A condition flow statement or block of statements. 
 
ELSE  
Statements to offer an alternative to other conditional statements. 
 
FOR/NEXT 
Acounter loop procedure that repeats code a specified number of times. 
 
DO UNTIL 
Used in programs to repeat code or return to the start of a procedure. 
 
LOOP 
Procedure that repeats code until or while a condition is true. 
 
 
Exercise 
 
Watch videos 1 - 4 and follow the procedures.  
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